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¢ Jaws PDF Creator® on Macintosh
platforms

Introduction

Jaws PDF Creator® converts PostScript language files into PDF files (Portable
Document Format). These files can subsequently be used with PDF viewing and
editing applications such as Jaws PDF Editor™ and Adobe® Acrobat® products, plus
any other third-party PDF tools. The PDF files produced by PDF Creator are fully
compliant with the PDF 1.3 and 1.4 specifications published by Adobe.

PDF Creator has two modes of operation:

Embedded mode: The application is embedded into the printing system of your
computer's operating system (OS) so that it appears as a PostScript compatible
printer to applications running on that computer. You can produce a PDF file from
any document by printing the document to the Jaws PDF Creator printer; in the
same way that you would produce hard-copy by printing to a real printer.

When creating PDF files, the printing system produces an intermediate PostScript
language form of your document, which PDF Creator immediately converts to PDF
and writes to disk.

Jaws PDF Creator works with PostScript printer drivers from Apple and Adobe.

Because PDF Creator is integrated into the printing system, it has no user interface
of its own. However, it does have a Control Panel (known as the Configuration Editor
on Mac OS X platforms) which allows you to configure various parameters affecting
the final PDF output.
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Standalone mode: A standalone version of Jaws PDF Creator, called Jaws ToPDF
takes an existing PostScript language file—either a legacy file or a file produced on
another computer—and converts it to PDF

About this manual

This manual is intended as a guide to the installation and use of PDF Creator.

* ‘Installing and uninstalling PDF Creator” describes how to install, upgrade and
uninstall PDF Creator.

»  "Getting started with PDF Creator’ covers basic use of both the Jaws PDF Creator
printer and the Jaws ToPDF application.

*  “Jaws ToPDF—converting files to PDF" describes the Jaws ToPDF application in
more detail.

» "Configuration Editor reference” provides a comprehensive reference for the PDF
Creator Configuration Editor (OS X)/Control Panel (OS 9). This is where most of
the configuration is done.

*  “Support” is where you will find all the support information you may require, such
as how to register your copy and download new versions.

e “Technical Information” contains technical and more advanced information about
PDF Creator as well as a map of all the installed files.

Throughout this manual, references to PDF viewer or PDF viewing application should be
understood to refer to Jaws PDF Editor", Acrobat Reader” and Acrobat®.

This manual describes Jaws PDF Creator operation on both Mac OS X and Mac OS
9.x platforms. Differences in operation, or features are indicated by using different
headings or separate paragraphs. In particular, details for Mac OS X versions are
prefixed with the Mac OS X: heading. Details for Mac OS 9.x versions are prefixed
with the Classic Mac: heading.

System Requirements

The system requirements are:
* Mac OS X: 10.2.x.
» Classic Mac: Mac OS 9.x.
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* Atleast 10 MB of free disk space.

*  Memory requirement is heavily dependent on the nature of the document being
converted into a PDF file.

Installing and uninstalling PDF Creator

Installation

PDF Creator can be installed on Mac OS X platforms or Classic Macintosh platforms
running Mac OS 9.x.

To install PDF Creator on a Macintosh platform:
| Temporarily disable any virus detection software.

2 Double-click the installer application that appears on your desktop when you insert
the CD-ROM into the drive.

3 Follow the on-screen instructions to install Jaws PDF Creator. Note that on
Mac OS X, you will be prompted for a password when you run the installer. This is
because the installer requires administrator privileges.

During installation, you can either enter a serial number or run in evaluation mode,
as described in “Serial number” below.

Serial number

If you have a serial number for your version of Jaws PDF Creator you can use it at
installation time. This will immediately give you a licensed and fully featured version
of the application.

If however you wish to evaluate the product, you can install it without a serial number.
To do this, click the Evaluation button.

This will provide you with a working copy of the application. In this case, all PDF files
generated by the application will contain a watermark on every page.
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Upgrade from evaluation to a fully working version

When you have evaluated Jaws PDF Creator you may wish to upgrade to a fully
working version.

Mac OS X: Open the Jaws ToPDF application and choose the Jaws ToPDF > About
Jaws ToPDF menu option.

Classic Mac: Open the Jaws ToPDF application and select About Jaws ToPDF from
the Apple menu.

The About dialog will appear. If you do not have a valid serial number, select the link
to the Jaws web site (www.jawspdf.com) and go to the How to buy page and
follow the instructions.

When you have your serial number you can upgrade your version of Jaws PDF
Creator.

Mac OS X: Click the Enter Serial Number option in the About Jaws PDF Creator
dialog box.

Classic Mac: Open the Jaws ToPDF application and select Enter Serial Number from
the Apple menu.
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The following dialog will appear:

To activate Jaws PDF Creater v3.0 from evaluation mode to a full
working copy, please enter your name, the name of the company for
whom you worle, and your product serial number.

User Name: A N Other

Company Name: My Company

Serial Number: |

N
\i_, Click the lock to prevent further changes. @

Please enter your name,the name of the company for
whom yvou work and the product serial number.

Name: AN Other

Company: My Company

Serial Number:

[ Cancel ] [ Evaluation ] |[ 0K ]|

Figure 2.1 Serial number dialog box

Enter your name, company and serial number and select Done or OK.

The user name must consist of at least two characters. The company name is
optional.

Your version of PDF Creator will become licensed and fully functional.

If required, you can amend an existing serial number or even remove it and revert
to an evaluation copy (possibly required if you want to check out the facilities of a
new version).

Uninstall PDF Creator

To remove PDF Creator from a Macintosh computer:
Double-click the install application and click Continue in the splash screen.

In the End User LICENSE Agreement dialog box click Accept to display the installer's
main window.
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3 Select Uninstall from the menu at the top left of the window and click the Uninstall

button.

4 On Classic Macintosh platforms, once the removal has completed, drag the PDF
Creator Desktop Printer icon to the Trash.

Getting started with PDF Creator

This section describes the main features of PDF Creator and how to use them.

Create a PDF file from an application

To create a PDF file directly from an application, print the document in the normal
way, ensuring that you select Jaws PDF Creator as the printer:

Print

Printer: | Jaws PDF Creator

3
B

Presets: | Standard

{ Jaws PDF Creator |-’%—i

Configuration: | (Press Ready) ]

PDF filename: | ju/Idisk/anonym /Documents/Untitled.pdf

[ Choose... |

@ (Prevlew‘\ { Save As PDF... \ Cancel

Mac OS X: Choose Jaws PDF Creator as the Printer and select the required

configuration and PDF file name in the Jaws PDF Creator pane before clicking
Print.
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Do not click the Save As PDF button and do not select Save as File in the output
Options pane.

21-8.7.1

Printer: [Jaws PDF Creator i] Destination:
r [ General i]
Copies:D [ Collated
Pages: @ All
Paper Source: @ All pages from: [l:lnlyl:lne i]
(I First page from: | onlyone 3]
Remaining from: [OnlyOne ¥ ]
Save Settings -

Figure 2.2 Print dialog

Classic Mac: When the Print button is clicked in the Print dialog a Save dialog
appears allowing you to choose the location and name of the PDF file. Clicking Save
completes the process.

Do not select the File option from the Destination menu. PDF Creator always
prints to a PDF file. If you select this option you will create a PostScript file instead.

Convert a PostScript or Encapsulated PostScript file to
PDF

Jaws PDF Creator can convert PostScript language or EPS (Encapsulated PostScript)
files to PDF.

When Jaws PDF Creator is installed, a desktop icon called Jaws ToPDF is created.

Mac OS X: Drag the PostScript or EPS file onto the Jaws ToPDF application.
Alternatively, select the document in the Finder, control-click to open the contextual
menu and select Open with > ToPDF.

Classic Mac: Drag the PostScript or EPS file onto the Jaws ToPDF application.
Alternatively, select the document in the Finder, control-click to open the contextual
menu and select Convert To PDF,
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The location of the PDF file is the same folder as the source document, although this
location can be changed, see “General tab” for details. The progress of the PDF file
creation is indicated by a progress dialog.

Create a PDF file containing bookmarks and links

PDF Creator includes an implementation of the PostScript pdfmark operator, which
is used to create PDF annotations. Some applications, such as FrameMaker®, directly
support the generation of PDF annotations. Others may require the use of special
macro packages or hand-made EPS files. In each case, any method of generating
annotations that works with other PDF creation applications also works with PDF
Creator.

The pdfmark operator is documented in Adobe Technical Note number 5150,
which is freely available from their web site.

Create a PDF file using a custom page size

If you are generating a PDF file intended mainly for on-screen viewing, you may want
to generate it with an unusual page size, so that it fits more neatly onto the screen.
The PostScript compatible interpreter in PDF Creator can accept any page size
specified via the setpagedevice operator.

Mac OS X: To use a custom page size, choose Custom Paper Size from the
Settings menu in the Page Setup dialog. You must specify a name for the paper size
as well as the dimensions. Ensure this paper size is selected when printing to Jaws
PDF Creator. For full details, see the Printing using a custom paper size Mac Help
procedure.

Classic Mac: To use a custom page, choose Custom Page Sizes from the
LaserWriter 8 Page Setup dialog that appears when you choose Page Setup... from
any application.

Change the name or destination folder of the PDF file

When you print to PDF Creator from an application, PDF Creator prompts you for
a destination folder for the output file, unless you enable the Always output files to
option in the General tab. The default destination folder is the last folder you used,
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and the file name is constructed from the document name provided by the
application. You may change either of these before clicking OK to save the PDF
output file.

Jaws ToPDF does not prompt you for the output file name, by default. Instead, the
output file is created in the same folder as the input file, and with the same name,
except for a .pdf extension. If you enable the Always output files to option in the
General tab, Jaws ToPDF places the file in this folder, but with the same name as the
input file (and a .pdf extension).

Note that the output files are saved as a PDF file type.

On Classic Macintosh platforms, if you select Always prompt for a destination in the
Configure Jaws PDF Creator dialog box, a prompt for an output file name appears
for each file. See “Jaws ToPDF configuration” for more information about configuring
the Jaws ToPDF application.

When the prompt for a name and destination folder appears you can also change
the security options. For more information, see “Security tab”.

Stop PDF Creator prompting for a file name

In the PDF Creator Configuration Editor/Control Panel, click the General tab and
select the Always output files to check box. Then select the folder in which you want
to save the PDF files. For more information, see “General tab”.

Turn off warning for non-DSC PostScript

On Classic Macintosh platforms, you are able to turn off warnings when PDF Creator
encounters non-DSC PostScript language files. For more information see “Jaws
ToPDF configuration”.

Produce PDF files compatible with PDF viewing
applications

Jaws PDF Creator can produce PDF version |.3 and | .4 files.

PDF |.3 and | .4 files are compatible with Jaws PDF Editor (although PDF Editor
cannot currently open PDF 1.4 files using 128 bit encryption).
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PDF .3 files are compatible with Acrobat v4.0 (or later). PDF | .4 files are compatible
with Acrobat v5.0 (or later).

NOTE: The PDF 1.4 files produced by PDF Creator comply with the Adobe specification, but do not
support all PDF |.4 features.

Produce files that can be sent by e-mail

To produce files that can more easily be sent by e-mail, select the General tab in the
PDF Creator Configuration Editor/Control Panel and select the ASCII format check
box. For more information, see “General tab”.

Produce more compact PDF files

There are several options that have an effect on the size of the output file, all of which
are available in the Font embedding tab and the Compression tab of the PDF Creator
Configuration Editor/Control Panel. The default settings after installation are
designed to give the maximum lossless compression for general use. The most
important options are:

Compress text: This option applies zip compression to the PDF commands in page
descriptions.

Subset embedded fonts: This option can help reduce the size of the output. If you
are working in a controlled environment, where you know which fonts are loaded
on the destination machines, choosing not to embed some or all fonts can further
reduce the size.

Image compression: Zip compression is usually the best overall compromise setting
as it is efficient and lossless.

JPEG compression: If you can tolerate lossy compression, that is, compression that
throws some of the data away never to be retrieved, you can use JPEG
compression.

Advanced users can also tailor the parameters used by JPEG compression.

These parameters are in the file startup.ps. See “Custom PostScript language
files” for further details.
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Zip with Predictor: You may find that Predictor compression sometimes improves
the performance on images where there are lots of similarly colored pixels. Note
that the terms Zip and Flate are interchangeable; they both refer to the same kind
of compression.

Launch PDF application to view the file when complete

Jaws PDF Creator can automatically launch any application on successful completion
of a job. For details on how to set the Launch application on job completion option,
see “General tab”.

Change the author name in the PDF file

The author name is the name that appears in your PDF viewer if you select File >
Document Info > General info. The author name that PDF Creator places in the Info
dictionary of a PDF file is a combination of the current user name and the computer
name. If the computeris not on a network, PDF Creator uses the name and company
you entered during installation. See “prologue.ps” for more information.

Note that it is possible to change this by editing the file prologue. ps. See “Custom
PostScript language files” for further details.

If you edit this file with a text editor; you will see the following lines:

% Here's how to change the Creator in the DocInfo
structure.

% Watch the ':' !

(: YourNameHere) DoAuthor

o°

Change YourNameHere to the text you would like, and remove the % from the
beginning of the line. PDF Creator uses this for the author name.

Jaws ToPDF—converting files to PDF

Jaws ToPDF is a front end to PDF Creator that lets you treat it as a standalone
application which allows you to convert existing PostScript language or EPS files to
PDF.
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Jaws ToPDF can accept PostScript language and EPS files including EPS with previews.
If Jaws ToPDF does not recognize a file format, it generates a warning before

processing.

Using Jaws ToPDF

You can use the Jaws ToPDF application to convert a file to PDF, in one of the
following ways:

* Drop a file onto the Jaws ToPDF application icon.
*  Choose Open... from the File menu.
* Drop a file onto the Jaws ToPDF application window.

When a file is being converted its progress is indicated:

8686 ToPDF

Drag and drop files to convert to PDF

Configuration: " test l-rH { Edit.. )

Submitted files:
| Filename | Status
23-32.P5 Complete

m

O laws PostScript to PDF Converter

Items remaining to be processed:

Input File: 1929 WC_4C.c.ps
Output File: 1929 WC_4C.c.pdf
[ Yiew “taiting Jobs

[
Figure 2.3 Jaws ToPDF application window
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The PDF file is saved in the default output folder, which is the same location as the
input file, unless the Always Output Files To option has been set in the General tab.

NOTE: If the destination file name already exists in this location, and the Overwrite an existing PDF
file option is not selected in the General tab, a unique number is appended to the file name.
An example of a name is: Book.pdf, Book 1.pdf, Book 2.pdf.

See “General tab” for more information.

Jaws ToPDF configuration

Open the Configuration Editor (Mac OS X) or the Jaws ToPDF Settings dialog box
(Classic Macintosh) as follows:

Mac OS X: Click the Edit button in the Jaws ToPDF application window to open the
Configuration Editor.

JAWS PDF CREATOR® ON MACINTOSH PLATFORMS INDEX | CONTENTS | € 17 )



JAWS PDF CREATOR® 3
JAWS PDF CREATOR® ON MACINTOSH PLATFORMS INDEX | CONTENTS | ¢ 18 »

Classic Mac: With the Jaws ToPDF application open, use the Settings > Configure...
option to open the Jaws ToPDF Settings dialog box.

|88 Config Editor

Configuration: " Untitled 1 M { Create... ) { Rename... | [ Remove )

Description:  None

F'Glml"{ Compression ' Font Embedding l Security l Advanced I

File Options

PDF File Format:  v1.3 @ -
Thumhbnail Generation: = None @ -

Resolution: dpi

1 ASClI Format
E Auto-Rotate Pages
"1 Optimize for Fast Web Viewing

Output Options
1 Always Output Files To: fUsers/Shared/ Eé Choose... |
! Launch on Job Completion: E Choose...
"1 View the PDF Document After Creation

[] Overwrite an Existing PDF Document

(‘?‘.
h

Jaws ToPDF Settings

Select the configuration that you would like Jaws
PDF Creator to use when generating PDF files:

Web copy s

Destination
’70 Always Prompt for a Destination

@ Do Not Prompt for a Destination

4 Warn for non-DSC Standard PostScript

[ Open Control Panel j [Eancelj H 0K jl

Figure 2.4 Jaws ToPDF configuration
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Three standard configurations are provided from the Configuration menu:

Press Ready: Optimized for sending jobs to a commercial printer at 2540 dpi (dots
per inch).

Print Quality: Optimized for printing to office type laser printers at 600 dpi.
Web: Optimized for screen viewing and for use in web pages at 72 dpi.

Any custom configurations you have created also appear in this menu. Note that you
cannot edit the standard configurations. On Mac OS X platforms, the names of
shared configurations are enclosed in brackets. For example, (my_conf). See
“Creating a new configuration (Mac OS X)" and “Renaming a configuration (Mac OS
X)" for detalls.

Mac OS X: You can use the Create, Rename and Remove buttons in the
Configuration Editor to create, modify and remove configurations. See “Managing
configurations on Mac OS X platforms” for more details.

Classic Mac: Use the Open Control Panel button to display the PDF Creator
Control Panel, where additional configurations can be defined. For more information
on how to create a custom configuration see “Settings tab (Classic Mac only)”.

In the Jaws ToPDF Settings dialog box (Classic Mac only), Jaws ToPDF can be
configured to either; prompt for an output file name, or to save the file in the default
output folder.

When you select Always prompt for a destination, a PDF Creator browser dialog is
displayed every time you convert a file. This allows you to change the output file
name or place it in a different folder.

If you select Do not prompt for a destination, Jaws ToPDF silently outputs the PDF
file to the default output folder: Although you can only change this setting from the
Jaws ToPDF application window, it also affects any jobs which are converted by being
dropped onto the desktop icon or shortcut.

Whether or not you ask Jaws ToPDF to prompt for a destination, it calculates the
default output folder in the same way. This is the same folder as the input file, unless
you have set the Always output files to option in the General tab, in which case it is
the folder you have specified. See “General tab” for more information about the
General tab. If you have configured Jaws ToPDF not to prompt for a destination, the
default output folder is used. If you have asked Jaws ToPDF to prompt you, the
browser dialog still allows you to change the output folder.
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Standard PostScript language files begin with the comment %! PS. If this comment is
missing, PDF Creator is still able to recognize the file as a PostScript language file and
process it in the normal way. On Classic Macintosh platforms, with the Warn for
non-DSC Standard PostScript option checked (as it is by default), any PostScript
language file encountered without a %! PS comment will cause an error message to
be displayed. You then have the choice whether to continue to process the file or not.

When you convert an EPS file, Jaws ToPDF uses the bounding box in the file to
determine the page size for the PDF file, and ignores the currently selected Use
%%BoundingBox for option. See “Advanced Options dialog box” for more
information.

When the configuration for the Jaws ToPDF application is completed, select OK.
Selecting Cancel aborts the changes made to the configuration.
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Configuration Editor reference

This section describes all the options available in the Configuration Editor.

NOTE: The Configuration Editor is known as a Control Panel on Classic Mac platforms.

| 88 Config Editor

Configuration: " Untitled 1 M { Create... ) ( Rename... ) { Remove j

Description: MNone

w Compression ' Font Embedding I Security ] Advanced l

File Options

PDF File Format:  v1.3 @
Thumbnail Generation: = MNone @ -

Resolution: dpi

1 ASClI Format
E Auto-Rotate Pages
"1 Optimize for Fast Web Viewing

Output Options
T Always Output Files To: fUsers/Shared/ | * Choose... |
! Launch on Job Completion: Choose_.. ;
"1 View the PDF Document After Creation

[] Overwrite an Existing PDF Document

@
S
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O==—-—F—————lawsPF reator =—"——————"H

Settings General Irmaging Font Embedding\/Security\/Reporting\

— Current Configuration

Description
The PDF file is optimized for sending to office laser printers.

— Confi ations

Duplicate... Create a new PDF configuration based on the current configuration.

Change the name or description of the current configuration.

Remove Rernowve the current configuration.

Figure 2.5 Configuration Editor/Control Panel

Use the following options to open the Configuration Editor/Control Panel:

Mac OS X: Click Edit in the ToPDF application window, or open the Configuration
Editor application, located by default in the Applications folder

Classic Mac: Select Apple Menu > Control Panels > Jaws PDF Creator.
Alternatively, with the Jaws ToPDF application open, use the Settings > Configure...
option and then click the Open Control Panel button.

Mac OS X versions of the Configuration Editor contain buttons that allow you to
create, modify and remove configurations, as described in “Managing configurations
on Mac OS X platforms"”. In Classic Macintosh versions of PDF Creator; equivalent
controls are located in the Settings tab within the Control Panel.

The PDF Creator Configuration Editor/Control Panel has a number of tabs for
different tasks. Click the various tabs to access and change the information contained
under that heading. “Settings tab (Classic Mac only)” through to “Reporting tab
(Classic Mac only)" describe the options contained within each tab.

Managing configurations on Mac OS X platforms

You can use the Create, Rename and Remove buttons in the Configuration Editor
to add, modify and delete configurations.
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NOTE:

Creating a new configuration (Mac OS X)

Click the Create button in the Configuration Editor to open the Add Configuration
dialog box, which allows you to create a custom configuration.

You must provide a unique name for the configuration in the Configuration text box.
Optionally, you can provide a Description of the configuration, such as its intended
use.

If you wish to duplicate the settings from another configuration, you should choose
it from the Based On menu.

If you have administrator privileges, you can click the Make available to all users
check box if you wish to allow other users to access the configuration. Otherwise,
this option is disabled. Note that only administrators can edit or delete shared
configurations. The names of shared configurations are automatically enclosed in
brackets. For example, my_conf becomes (my_conf) and (my_conf) becomes
((my_conf)).

Renaming a configuration (Mac OS X)

Click the Rename button in the Configuration Editor to open the Rename
Configuration dialog box, which allows you to change the name of the currently
selected configuration.

Check the Current name details to ensure that you are renaming the correct
configuration. You must enter a unique name for the configuration in the New name
text box.

If you have administrator privileges, you can make an existing configuration available to all
users by clicking the Make available to all users check box. The names of shared
configurations are automatically enclosed in brackets. For example, my_conf becomes
(my_conf) and (my_conf) becomes ( (my_conf)).

Deleting a configuration (Mac OS X)

Click the Remove button in the Configuration Editor to delete the currently selected
configuration. Note that you cannot delete any of the predefined configurations
(Web, Press Ready, Print Quiality).
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You cannot delete configurations created by other users, unless you have
administrator privileges.

Settings tab (Classic Mac only)

NOTE: On Mac OS X platforms, the controls described below are located at the top of the
Configuration Editor, rather than within a tab. See “Managing configurations on Mac OS X
platforms” for more details.

Typically, the options in this tab are the most frequently changed. You can choose the
default configuration that PDF Creator will use to create PDF files.

O==—-—F—————lawsPF reator =—"——————"H

Settings General Irmaging Font Embedding\/Security\/Reporting\

— Current Configuration

Description

The PDF file is optimized for sending to office laser printers.

_ Configurations

Duplicate... Create a new PDF configuration based on the current configuration.
Change the name or description of the current configuration.
Remove Rernowve the current configuration.

Figure 2.6 Settings tab

The menu in the Current Configuration section contains the name of the default
configuration. If you want to use a different configuration, choose another name from
the menu. This new selection is immediately available (you do not have to close the
dialog).

PDF Creator is supplied with three standard configurations that are suitable for most
uses:

Press Ready: Optimized for sending jobs to a commercial printer at 2540 dpi (dots
per inch).
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Print Quality: Optimized for printing to office type laser printers at 600 dpi.
Web: Optimized for screen viewing and for use in web pages at 72 dpi.

Note that you cannot edit the standard configurations. As each option is selected,
the window below contains a brief description of that option.

Creating a new configuration (Classic Mac)

If none of the existing configurations in the Settings tab (Classic Mac only) are
appropriate, you may create a new one.

Select the configuration which most closely matches your intended new
configuration and click Duplicate.

Although a unique name for the configuration is generated automatically, you may
want to change the name and description to reflect the intended use.

Editing a configuration (Classic Mac)

If you want to make changes to an existing configuration in the Settings tab (Classic
Mac only), other than one of the standard configurations, select it from the Current
Configuration menu then make the desired changes to the other tabs.

New options are immediately available (you do not have to close the dialog). To
abort recent changes use the Edit > Undo menu option.

Renaming or removing a configuration (Classic Mac)

You may change the name or description of an existing configuration in the Settings
tab (Classic Mac only) by selecting it and clicking the Rename button. You may
remove a configuration by selecting it from the list and clicking the Remove button.

The standard configurations that are shipped with PDF Creator may not be renamed
or removed, therefore these buttons are disabled when a standard configuration is
selected from the menu. If you do make changes to a standard configuration, you are
prompted to save the modified configuration with a new name.

Leading and trailing spaces are removed from the name. Configuration names must
be unique and are not case sensitive (that is, ConfigName and configNAME are
considered to be the same).
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General tab

The General tab provides options to configure the type of PDF file, the location for
the file and the actions to perform when the PDF has been created.

| 88 Config Editor

Configuration: " Untitled 1 P@! { Create... ) ( Rename... ) { Remove j

Description:  MNone

Fémﬂ-{ Compression ' Font Embedding I Security I Advanced ]

File Options

PDF File Format:  v1.3 @
Thumbnail Generation: = MNone E

Resolution: dpi

1 ASClI Format
E Auto-Rotate Pages
"1 Optimize for Fast Web Viewing

Output Options
T Always Output Files To: _#Usersfﬁhared,u‘ I Choose.., |
! Launch on Job Completion: " Choose..

"1 View the PDF Document After Creation

[] Overwrite an Existing PDF Document

(n?\,l

S

JAWS PDF CREATOR® ON MACINTOSH PLATFORMS INDEX | CONTENTS | ¢ 26 »




JAWS PDF CREATOR® 3
JAWS PDF CREATOR® ON MACINTOSH PLATFORMS INDEX | CONTENTS | ¢ 27 »

O=—————lawsPFreator =—"————"H

Settings \.-" General \.-" Irmaging \.-" Font Embedding\/Security\/Reporting\

— File Dptions

PCF File Format: | PDF 1.4 =
Thurnbnail Generation: | None = I

Resolution: dpi

D ASCI Format B Optimize for fast Web wiewing
B duto-rotate Pages

— Dutput Dptions
B Yiew the PDF File After Creation
D Overwrite an Existing PDF File

D #lways Qutput Files To Folder

D Launch &pplication on Job Cornpletion

I

Figure 2.7 General tab

The following items in the File Options section of the General tab, allow you to
control the format of the output file:

PDF file format: Use this option to create either PDF 1.3 or PDF | .4 files.
All PDF 1.3 and |.4 are compatible with Jaws PDF Editor.

PDF .3 files are compatible with Acrobat Reader v4.0. PDF |.3 and PDF | 4 files
are compatible with Acrobat Reader v5.0.

Note that PDF Creator v3.0 or later does not create PDF 1.2 files.

Thumbnail generation: Jaws PDF Creator can optionally generate thumbnail images
of each page (either monochrome or color), which can be used as a navigation aid
in your PDF viewing application. Some PDF viewers automatically create thumbnails
so leaving this option set to off can reduce the size of the generated PDF.

Resolution: This option allows you to change the effective resolution at which the
PostScript language job is rendered.This only affects jobs which contain resolution-
dependent (and therefore device-dependent) code. If your job contains pattern fills,
the printer driver attempts to snap the pattern frequency to a sub-multiple of the
device resolution. Some drawing packages also use the resolution (in conjunction
with the halftone frequency) to calculate the number of steps to use for graduated
fills. All other page elements should be unaffected by the resolution.
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If the PDF file is intended for printing, you should set the resolution to be the same
as the resolution of the intended final output device. Otherwise, you should only
change the resolution if you experience poor quality output with pages containing
patterns or graduated fills.

ASCII format: If this option is selected, any binary data (including compressed text)
in the PDF file is converted to a printable ASCII representation. This makes it safe to
transmit your PDF pages over a medium that does not support binary transmission
(internet e-mail for example). Using ASCII format will increase the size of your PDF
file.

Auto-rotate pages: PDF Creator will always honor requests for landscape output,
however some applications will produce landscape output by rotating the output
onto a portrait page. When printed, this is not a problem, as the page can easily be
rotated. However, when producing a PDF this leads to text running up the screen.

If this option is selected, PDF Creator will look for, and act on, the
%%ViewingOrientation DSC comment in the incoming PostScript job. The
%%ViewingOrientation comment explicitly specifies how to rotate the page from
its default orientation so that the PDF is produced at its optimum viewing orientation.

The %%ViewingOrientation DSC comment is inserted into the job by the
application generating the PostScript files and/or the printer driver. Not all
applications and drivers generate this comment.

If the $%ViewingOrientation DSC comment is present in a job, it will be used.
Otherwise PDF Creator will attempt to determine the orientation of the majority
of the text on the page, and rotate the page until this text is upright.

PDF Creator does this by looking at the text baseline and making it travel from left
to right, so it gets the result wrong if most or all of the text on the page is mirrored.

For more information on rotation, see "“Troubleshooting”.

Optimize for fast web viewing: Before distributing PDF files via the web you should
make sure they are created using this option.

This option may reduce file size, and prepares the document for page-at-a-time
downloading, sometimes called byte-serving. You will generally find that this option
significantly reduces the file size of your PDF document.
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When a document has been optimized for page-at-a-time downloading, the web
server sends each individual page of information requested by the user, rather than
the whole PDF document. When working with large documents, which can take a
long time to download, using the Optimize for fast web viewing option is particularly
important.

The following items in the Output Options section of the General tab, allow you to
control what happens to the PDF once it has been created:

Always output files to: If this box is checked, PDF Creator does not prompt you for
a destination file name, but outputs all PDF files to the specified destination folder.
The file name is composed of the document name (with a numerical suffix, if neces-
sary to avoid duplicate file names). This feature is mainly of use when using PDF
Creator to generate all files in a single location. In this case, you should also make
sure that you do not have Display Messages enabled in the Reporting tab,
described in “Reporting tab (Classic Mac only)".

The numeric suffix generation can be defeated using the Overwrite an existing
PDF file option. See later in this section for more information.

Mac OS X: Select the check box, then either enter the full path or click Choose to
select the required folder.

Classic Mac: When you select this option a Select Folder dialog box appears allowing
you to choose the required folder. If a folder has previously been selected, use the
Change button to choose a new location.

Launch on job completion: You can select an application, which PDF Creator exe-
cutes each time a job is successfully converted to PDF.

Mac OS X: Select the check box, then either enter the full path or click Choose to
select the required application.

Classic Mac: When you select this check box, a Choose Folder dialog box appears
allowing you to select the required application. PDF Creator sends the nominated
application an Open Document AppleEvent. If the application is not already running,
it will be launched. Within the Jaws PDF Creator:Scripts foldertwo scripts are
available for selection. The scripts Create Eudora Message and Create Outlook
Message open the respective applications with the previously generated PDF
selected as an attachment.
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View the PDF file after creation: Select this option to automatically open your gen-
erated PDF file using the system-registered PDF viewing application. If a viewing
application is not installed, nothing will happen.

Overwrite an existing PDF file: With this option selected, PDF files with the same
name as an existing file overwrite the existing file rather than create a file name with
an increment. This option only applies when the Do not prompt for a destination
option is selected. If Always prompt for a destination is selected you always have
the choice of overwriting or creating a new name.

Advanced (Classic Mac only) : Click the Advanced button in the General tab to
open the Advanced Options dialog box and access extra configuration options.

Advanced Options dialog box

NOTE: On Classic Macintosh platforms, advanced options are accessed by clicking Advanced in the
General tab to open the Advanced Options dialog box. The options in this dialog box as the
same as those in the Advanced tab of PDF Creator on Mac OS X platforms. See "“Advanced
tab (Mac OS X only)" for a description of advanced options.
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Compression tab

The sections in the Compression tab allow different compression techniques to be
applied to different types of images.

o888 Config Editor

Configuration: [Untitled i I-H ( Create... ) ( Rename... ) ( Remove )

Description:  None

l General ‘-ﬁm‘ Font Embedding I Security I Advanced ]

Color Images

Downsample: = None B‘ Resolution: 150 dpi
Compression: [None I-H

Grayscale Images

Downsample: = None B‘ Resolution: 150 dpi
Compression: "None I-H

Monochrome Images

Downsample: = None B‘ Resolution: 150 dpi
Compression: [None I-H

SCompress Text and Line Art

@ |
| .A
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Settings \.-" General \.-" Irmaging \.-" Font Embedding\/Security\/Reporting\

— Color Images
Downsample: | Bicubic E Resalution: dpi

Cornpression : [ JPEG — Mediumn Compression i]

— Gray le Images
bownsample: Resolutin: i

Cornpression : [ JPEG — Mediumn Compression i]

— Monochrome Images

Downsample: | Subszample B Resalution:  [z00 dpi

Comnpression: | CCITT Group ¢ >

B Compress Text

Figure 2.8 Compression tab

Downsample: These options allow you to control whether and how PDF Creator
reduces the resolution of images in the PostScript language file input.

Set this to 'Don’ t downsample' if your documents are intended for printing.
'Subsample' reduces the resolution of the image by dropping pixels.

'Average' reduces the size by averaging neighboring pixels and produces good
quality results. You cannot average a monochrome image in PDF Creator because

PDF Creator does not “promote” such images to grayscale.

'‘Bicubic' reduces the resolution by performing bicubic interpolation to generate
new pixel values. This option can generate more pleasing results though the PDF
will be slower to generate. Bicubic is not available with monochrome images.

Compression: There are three compression filters available for dealing with images.

The Zip filter uses a lossless compression technique and normally produces good
compression ratios. It can optionally apply a predictor algorithm which can further
improve the compression for some classes of image.
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The JPEG filter uses a lossy algorithm (which irretrievably discards data), but it pro-
duces excellent compression ratios on photographic images. You can optionally
modify some of the JPEG compression parameters by editing the file startup.ps,
as described in “startup.ps”.

The CCITT fitter uses standard fax compression, and is only applicable to bitmap
images. You can control the selection of group 3 or group 4 fax compression in
startup.ps. See “‘startup.ps” for details.

Resolution: If you have enabled downsampling, this option lets you specify the
target resolution of the reduced images actually embedded in the PDF file.

Compress text: If this is selected, PDF Creator compresses textual information,
such as page descriptions, using Zip compression.
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Font embedding tab

The Font embedding tab allows you to control how fonts are handled in your PDF

files.

088 Config Editor

H ( Create... ) ( Rename... ) ( Remove )

Configuration: [ Untitled 1

Description:  None

General | Compression Security | Advanced

Always Embed Never Embed
s s
52 ¥}
Add... Remove ( Add... ) Remove
E Embed All Fonts (Except Base 14 Fonts)
] Embed Base 14 Fonts
ESubset Fonts

A

JAWS PDF CREATOR® ON MACINTOSH PLATFORMS INDEX | CONTENTS | ¢ 34 )



JAWS PDF CREATOR® 3

JAWS PDF CREATOR® ON MACINTOSH PLATFORMS INDEX | CONTENTS | ¢ 35 )
O=—""—————laws PDf (reator ="—"———-—"-"1H
Settings\/m\/Compression\/Font Embedding\/Security\/Reporting\
Always Embed: Never Embed:
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[ Embed All Fonts (Except Base 14 Fonts)
[0 Embed Base 14 Fonts
[] Subset Fonts

Figure 2.9 Font embedding tab

Always embed: Fonts listed in this box are always embedded in the output PDF file.
Use the Add and Remove buttons to manage this list.

You should check the terms of your font license agreement before embedding any
fonts. Named fonts will be embedded if they are referenced in the original
PostScript language file and are available to PDF Creator.

Base 14 fonts in this list are always embedded, even if the Embed base 14 fonts
check box is not selected. This allows you to include individual base 14 fonts in a
document, rather than all base 14 fonts.

Never embed: Fonts listed in this box are never embedded in the output PDF file.
Use the Add and Remove buttons to manage this list.

Embed all fonts (except base |4 fonts): VWhen this option is selected, all fonts
present in the document (except base |4 fonts) are embedded in the output PDF
file and all fonts that were embedded in the PostScript language file (by the printer
driver or generating application) will also be embedded. If a font is referenced by
the incoming PostScript file and is available to PDF Creator, it will be embedded in
the generated PDF file.

If this option is not selected, the font will only be embedded if it is named in the
Always embed list.
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Any candidate for embedding is rejected if it is one of the base |4 fonts (unless it
appears in the Always embed list), or it appears in the Never embed list.

Embed base 14 fonts: If this is selected, all base 4 fonts present in the document
are embedded in the output PDF file. Selecting this option implicitly adds the base
|4 fonts to the Always embed list.

Note that if you wish to embed individual base |4 fonts, rather than all base 14 fonts,
you should add them explicitly to the Always embed font list, and deselect this
check box.

Subset fonts: With this option selected, only subsets of the original fonts are
embedded in the PDF file. This is the preferred setting, as it leads to smaller files.
However, selecting Subset fonts prevents you from subsequently using Acrobat
plug-ins or other tools that allow text editing within a PDF file, as not all characters
from the embedded fonts are available for use.

Security tab

The options under the Security tab provide various levels of protection for your PDF
documents.
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Select the Encrypt PDF files check box to enable the other options in the tab.

o888 Config Editor

Configuration: [Untitled i ﬁ ( Create... ) ( Rename... ) ( Remove )

Description:  None

l General I Compression I Font Embedding M Advanced ]

Encryption Level: 40-bit (PDF v1.3) RSA

SECURED

1 Encrypt PDF Files

Password Protection
Open Document:

Change Security:

Security Options
ZA”OW Copying of Text and Graphics
\_’,-'\Ilow Content Access for the Visually Impaired

Changes Allowed

ZDocument Assembly ZFiII in Forms and Signing
ZGeneraI Editing Z(_'ommenr Authoring
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Printing: = Enabled
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Figure 2.10 Security tab

Encrypt PDF files: Select this option to encrypt the PDF files created by PDF
Creator.

This option is, as a default, not selected which means that users of the PDF have full
access to the available options. When selected, the security options within this tab
become available and thus restrictions can be placed upon the user of the PDF
document.

The level of encryption depends on the selected PDF level, see “General tab” for
more information. With PDF |.3 you get 40-bit encryption. With PDF 1.4 you get
| 28-bit encryption.

Passwords

You can apply security to PDF files by entering passwords and restricting selected
features, such as editing and printing in the Passwords section of the Security tab.

A PDF file can have both an Open document password and a Change security password.
If both passwords are applied, the document can be opened using either one.

When the correct Open document password is provided, the document is opened
and decrypted. However, use of the document is limited by whatever restrictions
have been specified in the Security options section of the dialog.
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The Change security password allows the user to open the PDF and modify the
security settings. When a file is opened with a Change security password, you have
unrestricted access to the document, in effect, the security restrictions are
temporarily disabled. If you wish to limit access to your file, you should apply a
Change security password, otherwise anyone who opens the file is able to remove
the restrictions.

It is important to note that the PDF viewing application will not prompt for a
password if no Open document password is entered when creating a secured PDF.
This means that when only a Change security password is used, the document is
opened without the user having to provide a password, and use of the file is limited
by whatever security restrictions have been imposed. As a result, if the user only has
the free version of Acrobat, they are never able to obtain unrestricted access to the
document.

With Encrypt PDF Files selected, you can choose various options to define the level
of user actions allowed.

It is important to note that the options available in the Security Options and Changes
Allowed sections are different depending on whether you are creating PDF 1.3 or
PDF 1.4 documents. When you are creating PDF |.4 documents you have
independent control over the Allow Content Access for the Visually Impaired,
Document Assembly and Fill in Forms and Signing options. When creating PDF 1.3
documents these options are automatically selected at the same time as the Allow
Copying of Text or Graphics, General Editing and Comment Authoring options.

Security Options
The Security Options section of the Security tab contains the following options:

Allow copying of text and graphics: With this option selected, the PDF user is able
to copy and paste text and graphics from the file.

Allow content access for the visually impaired: With this option selected, the PDF
user is able to configure various reader options such as custom text, background
colors and create more visible color schemes.

Note: When generating PDF 1.3 files, the ...visually impaired option is disabled and
mimics the ..text or graphics option.

JAWS PDF CREATOR® ON MACINTOSH PLATFORMS INDEX | CONTENTS | ¢ 39 »



JAWS PDF CREATOR® 3
JAWS PDF CREATOR® ON MACINTOSH PLATFORMS INDEX | CONTENTS | ¢ 40 »

Changes Allowed

The options in the Changes Allowed section of the Security tab allow you to define
the level of changes you will allow users to make on the PDF document.

No options selected: With no options selected, users are unable to do anything to
the PDF document, including filling in signature and form fields.

Document Assembly: With this option selected, PDF users can insert, delete, and
rotate pages, and create bookmarks and thumbnails.

General Editing: When this option is selected, the PDF user can perform
Document Assembly and general editing, but cannot extract the contents of the
PDF.

Fill in forms and signing: Allows the PDF users to sign and fill in forms, but not
create them.

Comment Authoring: Allows the addition and editing of PDF (sticky note) com-
ments and use of the highlight pen, but not general editing.

Printing: Select either Enabled or Disabled to allow or disallow printing of the
PDF file.
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Advanced tab (Mac OS X only)

NOTE: On Uassic Macintosh platforms, you can access advanced options by clicking Advanced in the
General tab to open the Advanced Options dialog box. The options in this dialog box are the
same as those in the Advanced tab on Mac OS X platforms, which are described below.

o006 Config Editor

Configuration: | Untitled 1 |Gﬁq (Create“. 3 ': Rename... | | Remove )

Description:  None

1{ General [ Compression l Font Embedding [-Securitv

Color Options

Transfer functions: Apply E :
| Convert CMYK to RGB

"I Convert device independent colors to device dependent colors
1 Preserve Halftones
[l Preserve Overprint

E Preserve Under Color Removal and Black Generation information

Document Structuring Conventions (DSC)

Use %%BoundingBox for:  Nothing @ :

[ Preserve OPl comments

@

P

Figure 2.11 Advanced tab

The Advanced tab contains the following options:

Transfer functions: This menu provides the option of preserving, applying or
removing transfer functions from the PostScript language file. If you select the Apply
option, the document is displayed the same on-screen as when printed.
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Convert CMYK to RGB: This option only applies to color images. If it is enabled,
any four-color CMYK images in the PostScript language input file are converted to
RGB images in the PDF output. This can result in a smaller PDF file that displays
more quickly. You should enable this if your documents are intended for on-screen
viewing, and disable it if they are intended for printing.

Enabling this option can cause an apparent color shift in the images to which it is
applied. The conversion that PDF Creator uses is better suited to photographic
images than to CMYK approximations of spot colors. You may find that on-screen
reproduction of some graduated fills and tinted images is better with this option
disabled than with it enabled.

Convert device independent colors to device dependent colors: With this option
selected, PDF Creator converts colors specified in device-independent CIE-based
color spaces into device-dependent RGB. This produces PDF files which display
more quickly. Otherwise, these colors are converted into a device-independent cal-
ibrated RGB color space. This produces PDF files which render more slowly, but
whose colors are more constant across properly set up output devices.

Preserve halftones: With this option selected, any halftone changes requested by
the job are passed through to the PDF file. You should select this option when pro-
ducing PDF files for print, and disable it when producing PDF files for on-screen
viewing.

Preserve overprint: With this option selected, any changes to the PostScript graph-
ics state overprint parameter requested by the job are passed though to the PDF
file. This feature, along with Preserve OPI comments, Transfer functions, Under
Color Removal and Black Generation Information is intended primarily for use
within a pre-press environment.

Preserve under color removal and black generation information: This option
allows you to preserve or remove under-color removal and black-generation infor-
mation from the PostScript language file. This is normally only used in pre-press
environments.

Use %%BoundingBox for : As well as the conventional page size request embed-
ded in the PostScript language file, many files also contain comments describing the
actual extent of marks on the page. The Use %%BoundingBox for option lets you:
ignore these comments—>by selecting Nothing; use the bounding box for the PDF
page size—by selecting Page Size; or use the bounding box for the optional page
cropping box—by selecting Crop box.
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Acrobat Reader always displays pages as if they were the size specified for the page
cropping box. Some applications may generate their own cropping box information
using pdfmark, which overrides any cropping box set in this way.

Preserve OPI comments: OP| (Open Prepress Interface) is used to reduce net-
work traffic by substituting high-resolution images with low-resolution screen images
for the purpose of screen display and page make-up.

With this option selected, OPI comments in the PostScript language input file are
reproduced as OPI dictionaries in the PDF output.

It is not necessary for the high-resolution image data to be available to PDF
Creator—it passes the file name through to the output. PDF Creator produces only
an OPI |.3 dictionary, only an OPI 2 dictionary, or both, depending on whether the
PostScript language file input uses one or both versions of the OPI comments.

Reporting tab (Classic Mac only)

NOTE:  On Mac OS X platforms, you can access reporting options by choosing Jaws Configuration
Editor > Preferences. See “Preferences (Mac OS X only)"” for more details.

The Reporting tab allows you to control what happens to messages generated by
the PostScript language compatible interpreter.

O=—""—————laws PDf (reator ="—"———-—"-"1H

Settings \/M\/ Compression \/ Font Emnbedding \/ Security \/ Reporting \

[ Display Messages
[ Only Log Errors

() Discard Messages
@ Create Individual Log Files for Each lob
) Log All Messages To:

Figure 2.12 Reporting tab
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Display Messages: If this option is selected, PDF Creator displays all messages gen-
erated by the interpreter in an on-screen message box.

This is useful for debugging. You should not leave this option permanently enabled,
as the PostScript printer drivers normally cause messages to be generated
continuously—for a serial printer, this allows tracking of the job, but viewing each
message individually can become quite tedious.

Only log errors: If this option is selected, only error messages are written to the log
file—normal progress and user messages continue to be displayed (if that option
has been selected), but are not written to the log file.

Discard messages: If this option is selected, all messages from the interpreter are
discarded. This is of use in a batch environment. When enabled, this also causes all
error messages to be discarded, so you should use it with caution.

Create individual log files for each job: If this option is selected, PDF Creator cre-
ates an individual log file for each job, and writes messages generated by that job to
its log file. The log file is created in the same folder as the PDF file, and with the
same name, but with a . log extension. It may be viewed with a text editor. If the
messages are merely informative, the log file is created in addition to the PDF
output file. If an error occurs, the PDF file is not created, and the log file contains
the relevant error messages.

Log all messages to: If this option is selected, the messages generated by all jobs are
collected in a single log file.

The location and name of the log file can be entered into the text box. Alternatively,
use the browser to choose the location of the log file.

When you select this option, a Directory dialog box appears allowing you choose
the required name and location.

About Jaws PDF Creator

The About Jaws PDF Creator splash screen displays useful information about your
version of Jaws PDF Creator.

Mac OS X: To open the splash screen, choose the Jaws ToPDF > About ToPDF
menu option or the Jaws Configuration Editor > About Configuration Editor
option.
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Classic Mac: To open the splash screen, choose the About Jaws PDF Creator option
from the Apple menu.

The splash screen contains the following information:
Version: This is the version number of PDF Creator.

Kernel build: This is a unique identification of the version of PDF Creator that you
are using, and should be included on all bug reports that you submit.

Serial No. This is the Serial number you entered when installing the registered ver-
sion of PDF Creator: You need this if you wish to report bugs or otherwise require
support. If you installed a demonstration version of PDF Creator, this will read
Evaluation version.

Enter Serial Number: This option is used to license your version of Jaws PDF
Creator. For more information see “Serial number”.

Preferences (Mac OS X only)

With the Configuration Editor open, choose the Jaws Configuration
Editor > Preferences menu option to access message handling options.

The Configuration Editor Preferences dialog box appears:

e SR Config Editor Preferences

Message Handling
) Discard all messages
() Create individual log file for each job

@ Append all messages to: j|stel'stocuments," [ Choose..: )

[l Only include interpreter error messages in log file

Figure 2.13 Configuration Editor Preferences

Discard all messages: If this option is selected, all messages from the interpreter are
discarded. This is of use in a batch environment. When enabled, this also causes all
error messages to be discarded, so you should use it with caution.

Create individual log file for each job: If this option is selected, PDF Creator cre-
ates an individual log file for each job, and writes messages generated by that job to
its log file. The log file is created in the same folder as the PDF file, and with the
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same name, but with a . log extension. It may be viewed with a text editor. If the
messages are merely informative, the log file is created in addition to the PDF
output file. If an error occurs, the PDF file is not created, and the log file contains
the relevant error messages.

Append all messages to: If this option is selected, the messages generated by all
jobs are collected in a single log file.

The location and name of the log file can be entered into the text box. Alternatively,
click Choose to browse to the location of the log file.

Only include interpreter error messages in log file: If this option is selected, only
error messages are written to the log file—normal progress and user messages con-
tinue to be displayed (if that option has been selected), but are not written to the
log file.

Font management

To manage fonts, open the PDF Creator Configuration Editor (a.ka. Control Panel)
and choose the File > Manage Fonts option. Macintosh format fonts are supported.

The Font Management dialog allows you to control which fonts are installed and
available to the PDF Creator printer. These fonts are always installed on your disk, of
course, but you can control whether or not they are visible to PDF Creator, and
therefore whether or not they can be loaded by the PostScript £indfont operator.

This option makes no distinction between PFB format, PFA format (an ASCII format
for Type | fonts typically used on UNIX platforms), or raw PostScript files containing
Type 3 fonts. All of these fonts are displayed as PostScript fonts in this dialog, and all
may be successfully installed for use with PDF Creator.

The core fonts that are installed with PDF Creator cannot be removed and are
indicated with a “lock” icon. The core font set includes clones of the 35 standard
PostScript printer fonts, as well as stub files which refer to them. For example,
Helvetica is one of the standard fonts, but the font file for Helvetica is just a stub that
substitutes the clone font Helsinki instead.

The reasons for wanting to make the fonts visible to PDF Creator differ for the two
formats. The principal reason for installing Type | fonts is if you are using Jaws ToPDF
to convert files which do not contain embedded fonts—for example, if they were
created on a different machine. If you try to convert such files without making the
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NOTE:

fonts available to PDF Creator, the document is converted with incorrect text
metrics. By making the fonts you need available to PDF Creator, the document is
converted with all the correct fonts and spacing.

If you add a Type | font to PDF Creator because it is used but not embedded in a
PostScript language file, remember that it is not embedded in the PDF output files

unless you also add it to the Always Embed list in the Font embedding tab. See “Font
embedding tab” for more information.

Clicking the Select Folder button displays a browser dialog, allowing you to select the
folder where PDF Creator can find the fonts you want to add. The System Fonts
button is a shortcut, equivalent to opening the fonts folder.

Importing configurations
This option is available on Mac OS X platforms only.

You can use the Import configurations option to import an XML file, containing the
PDF configuration(s) from another machine or user. To create such an import file,
you must use the Export configurations option, described in “Exporting
configurations”. For example, this option can be used to ensure all users within an
organization have the same configuration settings and therefore create PDF
documents of the same type.

To import an XML configuration file:

With Jaws Configuration Editor active, select Import Configuration from the File
menu.

Use the displayed browser to choose the XML file to be imported. The file will have
a .xml extension.

Click Open to import the file.

Choose the configuration(s) you wish to import. Use the Command key to select
multiple configurations.

If you wish to make the configuration(s) available to other users, select the Make
available to all users check box (requires administrator privileges).
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6 Click Import.
NOTE: When an XML file is exported and subsequently imported, the Always output files to and

NOTE:

NOTE:

NOTE:

Launch on job completion locations are not transferred. This is because these locations are
system specific and may not be appropriate on your system.

Exporting configurations
This option is available on Mac OS X platforms only.

You can use the Export configurations option to export an XML file, containing
details of your configuration(s), for use on another machine or by another person.
This XML file can be transferred between Macintosh and Windows versions of Jaws
PDF Creator. To import such an XML file, you must use the Import configurations
option, described in “Exporting configurations”. For example, this option can be used
to ensure all users within an organization have the same configuration settings and
therefore create PDF documents of the same type.

An XML file is a text file which can be opened and hand edited. However, doing this may cause
your version of Jaws PDF Creator to produce unexpected results or fail.

To create an XML configuration file for distribution to other users of Jaws PDF
Creator:

Ensure all your configurations are correct in all details.

With Jaws Configuration Editor active, select Export Configuration from the File
menu.

Choose the configuration(s) you wish to export. Use the Command key to select
multiple configurations.

Click Export.

Use the displayed browser to choose a location and name for your XML file. Ensure
the file has a .xml extension.

Click Save to save the file.

When an XML file is exported and subsequently imported the Always output files to and
Execute on completion locations are not transferred. This is because these locations are
system specific and may not be appropriate on your system.
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Support

This section offers support and troubleshooting advice.

Downloading PDF Creator

You are able to download further copies of PDF Creator from:
*  www,jawspdf.com.

To download an installer you must either provide a valid serial number or legitimate
e-mail information.

Have the following information ready:
*  Serial number (if you have one)
* Your name
* Job title
*  Company name
* Telephone number
* E-mail address
* Platform on which PDF Creator is going to be used

* language

Reporting problems

There is a FAQ section under the Support page at www.jawspdf.com.
If your problem is not covered here, you should submit a bug report.
When submitting a problem you should provide the following information:
*  Operating system (For example, Classic Macintosh or Mac OS X)
*  Version of PDF Creator

* Kernel build time (the kernel build time uniquely identifies the PDF Creator kernel
you are using)
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Class of problem (kills application/kills PDF Creator/kills Operating System/incorrect
output)

Detailed description of problem
Contact details
The kernel build time is available in the About Jaws PDF Creator splash screen.

Mac OS X: To open the splash screen, choose the Jaws ToPDF > About ToPDF
menu option.

Classic Mac: To open the splash screen, choose the About Jaws PDF Creator option
from the Apple menu.

Registering PDF Creator

Jaws PDF Creator can be registered on the World Wide Web. Point your browser
at www.,jawspdf.com and select the Support page and fill in the form. You should
have the following information ready:

Your name

Company name and address

E-mail address

Company size

Where PDF Creator was purchased
Number of copies purchased

The serial number supplied with the software

Contact information

If you need to contact Global Graphics Software Limited directly for any reason, you
can use the address and numbers below:

Global Graphics Software Limited
Barrington Hall

Barrington

Cambridge, CB2 5RG
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United Kingdom

Tel: +44 (0) 1223 873 800

Fax: +44 (0) 1223 873 873

Web site: www.jawspdf.com.

Mail regarding PDF Creator can be sent to sales@jawspdf.com.

Troubleshooting

This section offers some troubleshooting advice:

Acrobat Reader displays text as bullets: This is normally a problem with Acrobat
incorrectly calculating the size of text displayed when using an embedded TrueType
font. In Acrobat Reader’s File > Preferences > General dialog, deselect the check
box labelled Greek text below... pixels.

Acrobat Reader does not display some text: There are some undocumented
restrictions on the commands which Acrobat Reader accepts in embedded CFF
fonts (PDF Creator uses the CFF format for all embedded Type | fonts; you can find
out the type of fonts used in your documents using the menu option File >
Document Info > Fonts dialog in Acrobat Reader).

Where the PDF file produced by PDF Creator contains such unsupported
commands, Acrobat Reader displays some characters in the font concerned as
blanks. Please submit a bug report if you find such a font.

Text which should be outlined is displayed as solid: This appears to be a problem
with the way Acrobat Reader displays certain Type 3 fonts. The document prints to
a PostScript language-compatible printer correctly.

Bitmaps which should be transparent mask the background color: Acrobat
Reader sometimes has problems displaying large bitmap masks, displaying them as
opaque images instead. Use the Acrobat Reader menu option File > Preferences >
General to open the General Preferences dialog, and unselect the Smooth Text
and Images check box.

Invalidaccess error with setdistillerparams: The setdistillerparams operator
is the way that PDF settings are controlled from within a PostScript language file.
PDF Creator supports mostly the same set of parameters that other PDF creation
applications support, although there are some extra parameters for PDF Creator
(which are used by the PDF Creator Configuration Editor/Control Panel), as well as
some parameters which do not make sense for PDF Creator.
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You only ever see this message if you attempt to distill a PostScript language file
which explicitly requests LZW using the setdistillerparams operator: If so, you
should amend the PostScript language file to request Zip compression instead.

Colors in the PDF file do not match original colors: If you have enabled the
Convert CMYK to RGB option (see the Advanced tab (Mac OS X only) or the
Advanced Options dialog box (Classic Mac)), you may find that the color reproduc-
tion of some images is compromised. There is no universal way to convert CMYK
images to RGB for on-screen viewing. The algorithm that PDF Creator uses for this
conversion has been tuned to work well with photographic images. This means that
it may not work so well for tinted images or graduated fills where the CMYK color
contains a large black component. If this happens, you should deselect the Convert
CMYK to RGB option: This results in slightly larger PDF files, but should have no
other side effects.

Rotation and applications and drivers that do not generate
%%ViewingOrientation: For applications and drivers that do not generate
%%ViewingOrientation DSC comments a new option, called
PageOrientation, has been added to the printer driver. By default
PageOrientation is switched off and the auto-rotate setting in the PDF Creator
configuration is respected. There are four other options: “Rotate by O degrees”,
“Rotate 90 degrees counter-clockwise”, “Rotate 90 degrees clockwise” and “Rotate
|80 degrees”. These four options all switch off auto-rotate (if it was enabled) and
apply the specified rotation to the page. The page is rotated from its default
orientation. Because different applications do different things when, for example,
they are asked to generate a landscape page from a portrait page (and vice versa),
some trial and error is required.
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Technical Information

How PDF Creator works

This section describes how PDF Creator works and how it integrates with the
operating system. The information contained here is not essential for using PDF
Creator however an understanding of the information will help you get the most out
of the product.

PDF Creator is built around a complete PostScript language-compatible interpreter.
In the case of PDF Creator, the interpreter is called Jaws and is a clone interpreter
developed for incorporation into hardware and software products. Also the raster-
based back-end of the interpreter has been replaced with code which outputs
graphical primitives as text—in this case, the text builds up into PDF page
descriptions. It is also possible to convert PostScript language files into other page
description languages using the same approach.

The PostScript language-compatible Jaws interpreter allows a number of
transformations to be carried out in the interpreter pipeline, which is how PDF
Creator implements features such as TrueType font substitution.

Integration with the operating system

On Mac OS X platforms, PDF Creator is implemented as a CUPS printer and
backend. On Classic Macintosh platforms, PDF Creator implements a custom hose
which allows a developer to process the PostScript language output from the
LaserWriter driver version 8.6 or later in any way.
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When the interpreter starts up—normally before every job is processed—it
executes the file startup.ps. This file may contain any code that is to be executed
once for all jobs. You should only modify this file if you are capable of writing
PostScript language code. It contains the default parameter sets used by the image
compression filters, and the lists of TrueType fonts which require special handling by
PDF Creator. For more information about the contents of startup.ps see Section .

In addition, the PostScript language-compatible interpreter executes the file
prologue.ps at the start of every job it converts. This file can contain any
PostScript language code that needs to be run for every job. An example of this is
the code that changes the contents of the document info dictionary in the PDF
output file, described above. It also executes the file epilogue.ps at the end of
every job. This may be used, for example, for any pdfmark calls that you may want
to apply to every job you convert. See Section for more information on
prologue.ps and Section for more on epilogue.ps.

Advanced topics

This section describes topics to do with file names and font embedding.

File names

PDF Creator has two strategies for creating the output file name, depending on
whether you are using the PDF Creator printer or are converting files with Jaws
ToPDF.

When you are printing directly to PDF Creator from an application, the document
name passed to it by the printing system is used as a starting point from which to
generate the name of the PDF output file.

If the document ends with a recognized suffix (.ps or .eps) it is removed before
.pdf is appended.

This is the file name which PDF Creator offers you in the Save dialog box it normally
displays for every job.

The output folder is determined by considering the following options:

* The folder specified by the Always output files to option in the General tab in the
PDF Creator Configuration Editor/Control Panel, if selected.
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NOTE:

The last folder to which PDF Creator wrote a PDF file.

Unless the Always output files to option is selected, PDF Creator always provides
you with the opportunity to change both the folder and the file name using a browser
dialog.

At times, you may be surprised at the file names that PDF Creator generates in this
way. The reason for this is that the document name is not normally used by the
printing system, except in dialogs, to provide information about the status of the job.
This means that there is no official format for the document name, and most
applications make up their own rules.

Therefore, PDF Creator may offer a default file name that is different to that which
was expected. However, the file name that PDF Creator generates is always legal.

The colon (:) is the only character that is not valid in a Macintosh file name.

PDF Creator never overwrites an existing output file without prompting, unless the
Overwrite an existing PDF file option in the General tab of the Configuration
Editor/Control Panel is selected.

If you have selected Always output files to from the General tab and a file with the
same name already exists, PDF Creator appends a unique number to the file name.

When you use Jaws ToPDF to convert existing files, PDF Creator uses the input file
name instead of the document name (because there is no document name) as the
basis for the output file name. PDF Creator uses the name and location of the input
file as the default destination, except that the file extension is replaced by .pdf. If
Always output files to is selected from the General tab, the file is saved in this
location. If not, PDF Creator displays the browser dialog and allows you to change
the output file name.

See Section for more information on the General tab.

Font embedding

PDF files are capable of containing fonts in three different formats. PDF Creator is
able to handle all three. Jaws PDF Creator only ever embeds fonts that were
embedded in the original PostScript language file. Fonts that were read from disk,
including the base 14 PDF fonts (but not including TrueType fonts read as part of the
substitution process described below), are not embedded unless they are selected
for embedding. See Section for more information.
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Type | fonts

Type | fonts are the traditional format for hinted fonts in the PostScript language
community. Type | fonts are always handled in a standard way by printer drivers, and
PDF Creator can always extract them from the document and embed them in the
PDF file. PDF Creator always converts Type | fonts to the new CFF (Compact Font
Format), which is a more compact way of encoding the same information. Version 3
of Acrobat supports both the original Type | format and the Compact Font Format;
however, there are some undocumented restrictions in the CFF commands that
Acrobat Reader understands. For this reason, you may sometimes find that PDF
Creator embeds a Type | font which will not display correctly on screen, but which
does print correctly from Acrobat to a PostScript language compatible printer. If you
encounter such a font, you should submit a PDF Creator bug report, which will
enable us to comply better with the undocumented restrictions.

Type 3 fonts

Type 3 fonts are the format used in the PostScript language community for unhinted
fonts (such as complex logotypes and bitmap fonts). PDF Creator does support Type
3 fonts, and will embed them.

TrueType fonts

TrueType is an alternative format for hinted fonts, which originally evolved in the
personal computer community, rather than the PostScript language community. Many
modern PostScript language compatible interpreters (including PDF Creator) are
able to handle TrueType fonts directly, but for historical reasons, PostScript printer
drivers make life more difficult.

The following paragraphs describe how the various PostScript printer drivers handle
TrueType fonts, and how PDF Creator's TrueType font substitution works with each
of them.

TrueType fonts with the Mac OS LaserWriter driver

These are the easiest to handle. The Mac OS printer driver embeds TrueType fonts
in the PostScript language file as Type 42 PostScript fonts. PDF Creator can handle

these directly and embed the font in the PDF output file. This happens regardless of
whether TrueType substitution is on or off.
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PostScript ProcSet resources

Fonts are one kind of resource that the PostScript printer driver may embed in a
PostScript language file. Procedure sets, or ProcSets are another. Typically, both the
printer driver and the application itself can generate ProcSets, which are used to
define PostScript language procedures which are frequently used by the document.
These ProcSets are identified by comments within the PostScript language file.

The convention used for these identifying comments allows a printer driver to omit
a resource from a file when it is first generated, and subsequently arrange either for
the printer to read the resource off disk, or for the spooler to insert the resource
into the job immediately before sending it to the printer.

Control over application-generated ProcSets is left to the individual applications, and
may not be possible.

You can instruct PDF Creator to intercept ProcSet resources in files sent to it, and
save them to disk for later use. This option is not accessible from the PDF Creator
Configuration Editor/Control Panel. Instead, you must find the following lines in the
file prologue.ps (see Section for detalils):

% Here's how to turn on Resource Capturing.Uncomment
the next line
%systemdict /NiknakDict get begin /ExtractResources
true def end

To enable saving of ProcSet resources to disk, uncomment the line by removing the
% character from the beginning of the line. Once the ProcSets have been saved to
disk, you are able to send jobs with the ProcSet resources omitted to PDF Creator,
and have them processed properly. If PDF Creator detects that a job requires a
ProcSet resource that has not been saved to disk it issues a warning message to that
effect, although the job will probably fail with a PostScript language error.

PostScript ProcSet resources normally have a version number as well as a name; PDF
Creator treats ProcSets with the same name but different version numbers as being
completely different.
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When using this feature, you should bear in mind that ProcSets are PostScript
language code and usually subject to copyright restrictions. Saving the resources to
disk is equivalent to permanently downloading them to a printer—the authors of
your application may or may not have granted you permission to do this.

You should only make use of this feature if you are working in a controlled
environment and you are already comfortable with the idea of ProcSet resources.

Custom PostScript language files

There are three PostScript language files that are executed by the interpreter:
e startup.ps
* prologue.ps
* epilogue.ps

These files are in the following location:

Mac OS X: /Library/Applications/Support/Jaws PDF
Creator/JawsFolders/default/

Classic Mac: Jaws PDF Creator:Jaws PDF Creator Resources:Default:

You can use these files for any custom PostScript language code that you want to be
executed. Needless to say, you should only modify these files if you are comfortable
with writing PostScript language code.

startup.ps

This file is executed when the interpreter first starts up. You can use it to make any
global changes. In particular, the parameters that PDF Creator uses for the JPEG and
CCITT image compression filters are stored here, as well as the lists of TrueType
fonts that need special handling by the TrueType substitution code.

The image compression parameters are stored in four PostScript dictionaries at the
start of the file, which give the parameters for the JPEG low, medium and high
compression filters, and the CCITT fax compression filter respectively. If you
understand how the PostScript compression filters work, you can modify the
parameters here to change the behavior of the filters. The most common example
might be to change the Q factor for one or more of the JPEG filters.
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The TrueType dictionaries are stored near the end of the file, and are initially empty.
You can add the names of any fonts that you have determined require special
handling by the TrueType substitution code. For more information on the format of
these dictionaries see Section , “Font embedding”.

prologue.ps

This file is executed by the interpreter at the start of each job. This gives you the
opportunity to make any changes that you want to apply on a per-job basis.

There are three pieces of example code here that you can use directly. The first
section of code enables collection of PostScript ProcSet resources. The line:

systemdict /NiknakDict get begin /ExtractResources true
def end

turns on the collection of resources from incoming PostScript language jobs. After
installation, this line is commented out—the % at the start of a line introduces a
PostScript language comment. To enable collection of ProcSet resources,
uncomment the line by removing the %, using a text editor. When you have collected
all the ProcSet resources you need, you should comment out this line again.

The code to override the default author and creator information is also located here
(normally extracted directly from the PostScript language file being converted). The
code for each field is similar.

The PostScript procedure DoAuthor changes the author name:

(: YourNameHere) DoAuthor

This causes YourNameHere to appear as the author of the document. DoAuthor
works by mangling the %$%Author comment present in the job, which is why the
operand to DoAuthor must start with a colon and space before the name itself.

The PostScript procedure DoCreator changes the creator in the same way:

(: CreatorName) DoCreator
After installation, the example lines for DoAuthor and DoCreator in prologue.ps
are both commented out. If you wish to change the author or creator information,

you must uncomment these lines by removing the initial % as well as changing the
strings to reflect the names that you want.
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epilogue.ps

This file is executed by the interpreter at the end of each successful job. Any
PostScript language code placed here is included in the PDF file (if it generates any
pages of output). More importantly, you may wish to place any calls to pdfmark here
that you want to be applied to all jobs you convert.

Using PostScript plugins

Jaws PDF Creator has the ability to dynamically load PostScript language plugins.
PostScript language plugins can be used to implement extra features. For example,
we have supplied the following plugins:

* XPressTrim.jcp - an idiom set that catches crop marks in QuarkXPress jobs and
adds a TrimBox to the page.

* CorelTrim.jcp - an idiom set that catches crop marks in CorelDraw jobs and adds
a TrimBox to the page.

* ConfigRecorder.jcp - adds a text annotation to the first page of the job,
recording the Jaws PDF Creator configuration used to make the PDF file.

These plugins are stored in the Plugins (inactive folder), see Section for
further details. To use a plugin, you must copy the relevant . jcp file into the
default folder.

Please see the www.jawspdf.com website for the latest list of available plugins.

You can also create your own PostScript plugins. All such plugins should be given a
. jep extension. We recommend you place your PostScript plugins in the Plugins
(inactive) folder Any plugins you wish to make active should be manually copied
into the default folder; in the same way as the supplied plugins.

The plugins are executed alphabetically, and if a particular plugin fails, the remaining
plugins will still be executed. All actions can be viewed in the Jaws PDF Creator log
file.

Visit www.jawspdf.com for information on new plugins for Jaws PDF Creator.

If you have questions, contact creator-support@jawspdf.com.
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Map of installed files

The following tables list all the folders and files placed on your disk when you install
PDF Creator.

Macintosh installation files
The following folders and files are installed on Mac OS X platforms:

Jaws PDF Creator/

The default installation folder. This folder is created in the Applications folder,
unless you choose a different location in the Installer.

ToPDF

The PostScript language to PDF conversion utility.

Configuration Editor

The Configuration Editor. See “Configuration Editor reference” for details.
Read Me

A SimpleText file containing important user information.

Jaws PDF Creator Manual.pdf

Manual in Acrobat PDF format.
The following folders and files are installed on Classic Macintosh platforms:

Jaws PDF Creator:

The default installation folder. This folder is created in Applications folder; unless
you choose a different location in the Installer.

Jaws ToPDF

The PostScript language to PDF conversion utility.
Read Me
A SimpleText file containing important user information.

Make Jaws PDF Creator

A small application that creates the PDF Creator Desktop Printer that is necessary
for printing from any application. Since a Desktop Printer is automatically created by
the installer, you should not normally need to use this application.
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Jaws PDF Creator Manual.pdf
Manual in Acrobat PDF format.
Scripts:

Folder containing two scripts: one for Eudora and one for Outlook Express. For more
information see “Launch on job completion”.

Jaws PDF Creator Resources:
This folder contains the following items that are required by PDF Creator.
Jaws PDF Creator File App

A small application that prompts you to enter a PDF file name. This is used by PDF
Creator during the conversion process.

Default

See “General files used by all operating systems”.
Font

See “General files used by all operating systems".
Resource

See “General files used by all operating systems”.
Plugins (active)

See “General files used by all operating systems".

Jaws PDF Creator Resources (Mac OS X only):

/Library/Printers/PPD Plugins/Jaws PDF Creator PDE.plugin
Implements the Jaws PDF Creator pane in the Print dialog (Print Dialog Extension).
/Library/Printers/PPDs/Contents/Resources/en.lproj

The PostScript Printer Description file, it defines the capabilities of the PDF Creator
printer.

/Library/Application Support/Jaws PDF Creator/PostProcessingApp

A helper application used to support post processing of PDFs.
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/Library/Preferences/ or ~/Library/Preferences/

Configurations and user settings are saved in preferences files. These are located in
/Library/Preferences/ if global, or ~/Library/Preferences if user-specific.

/usr/libexec/cups/filter/jawspdfcreator

The CUPS printer which converts the PostScript file to a PDF file.
/usr/libexec/cups/backend/jawsbackend

The application which writes the PDF to disk.
/Library/Application/Support/Jaws PDF Creator/JawsFolders/
This folder contains the following items that are required by PDF Creator.
default

See “General files used by all operating systems".

fonts

See “General files used by all operating systems”.

resources

See “General files used by all operating systems".

plugins (active)

See “General files used by all operating systems”.

1lib

This folder contains library files that are required by Jaws PDF Creator.
SYSTEM FOLDER ITEMS (Classic Mac only)

Control Panels

Jaws PDF Creator. The Jaws PDF Creator Control Panel.
Preferences:Jaws PDF Creator Preferences

This file contains all of your PDF Creator Preferences and configurations.
Extensions:Printing Plug-ins:Jaws PDF Creator:

The core PDF Creator PostScript language to PDF converter library.
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Extensions:

Folder containing the following components of the Apple LaserWriter driver v8.6.
LaserWriter 8

The Apple LaserWriter 8.6 PostScript Printer driver.

PrintingLib

A shared library required by the LaserWriter driver.

Printer Descriptions:Jaws PDF Creator PPD

The PostScript Printer Description file, used by the LaserWriter driver; it defines the
capabilities of the PDF Creator printer.

General files used by all operating systems

epilogue.ps

A PostScript language file run after every job (see Section ).

prologue.ps

A PostScript language file used to configure PDF Creator (see Section ).
startup.ps

A PostScript language file run at startup, contains compression settings (see Section ).
Default:

A folder PDF Creator uses for miscellaneous files.

Font (s) :

The folder PDF Creator uses for the 35 resident fonts.

The data in these files is copyright Stream Technologies Inc., and is not licensed for
use with any software other than PDF Creator.

Resource(s) :

This folder contains all the PostScript resources (other than fonts) that are known to
the interpreter, and which may be loaded by the findresource operator.

Plugins (inactive):

This folder contains some PostScript language plugins which can be used to
implement extra features. See Section for further details.
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COPYRIGHT AND TRADEMARKS

Jaws PDF Creator User Manual—Macintosh

Version 3

Document Issue: 101

December 2003

Part number: JAWS-3-4-0-PDFCreator

Copyright © 1992-2003 GLOBAL GRAPHICS SOFTWARE LIMITED

All Rights Reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted, in any form or by any
means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of Global Graphics Soft-
ware Limited.

The information in this publication is provided for information only and is subject to change without notice. Global Graphics Software
Limited and its affiliates assume no responsibility or liability for any loss or damage that may arise from the use of any information in
this publication. The software described in this book is furnished under License and may only be used or copied in accordance with
the terms of that License.

Jaws, the Jaws logo, Jaws PDF Creator, Jaws PDF Editor, Jaws PDF Server and Jaws PDF Courier are trademarks of Global Graphics
Software Limited, which may be registered in certain jurisdictions. Global Graphics is a trademark of Global Graphics S.A., which may
be registered in certain jurisdictions.

Adobe, Adobe Photoshop, Adobe Type Manager, InDesign, Acrobat, Display PostScript and PostScript are registered trademarks and
Distiller and PostScript 3 are trademarks of Adobe Systems Incorporated.

Other brand or product names are the registered trademarks or trademarks of their respective holders.

Licensed under U.S Patent No. 4,558,302 and foreign counterparts.

END USER LICENCE

This Licence (and the terms and conditions contained within it) is a legal agreement between you (the End User) and Global Graphics
Software Limited, a company incorporated in England with Company No 2049413 with registered office at Barrington Hall, Bar-
rington, Cambridge CB2 5RG or in the United States with Global Graphics Software Inc, a company incorporated in Massachusetts,
with a principal address at 95 Sawyer Road, Three University Park, Waltham, MA 02453 (both defined for the purpose of this Licence
as Global Graphics). This Licence sets out the terms upon which Global Graphics and its licensors licences to the End User the Soft-
ware. The End User must only install and use the Software in accordance with the terms of this Licence and the End User’s particular
attention is drawn to the terms of the licence (Clause 2) (and the restrictions and prohibitions contained within that Clause), the lim-
ited warranty (Clause 3) and the limitation of liability (Clause 4).

By installing, loading, copying, storing or otherwise using the Software, the End User agrees to be bound by the terms of this Licence.
If the End User does not wish to be bound by the terms of this Licence, the End User should not install, load, copy, store or otherwise
use the Software, and return the Software or the Documentation for a refund of the Total Charges.

I INTERPRETATION
[.I' The expressions set out below shall have the meanings in this Licence ascribed to below:

.2 Charges mean the fee payable by each End User as identified in the Purchase Order and Total Charges means the total fees
payable by all End User's;

[.3 End Users means the individual or company licensed to use the Software under or in respect of this Licence as set out in the
Purchase Order;

4 Intellectual Property means copyright, domain names, design rights, database rights, semi-conductor topographical rights, pat-
ents, trade marks (registered or unregistered), service marks, registered designs or any applications thereof, and all other intel-
lectual or industrial property rights of a similar nature and Intellectual Property Rights means rights in such intellectual
property;

I.5  Purchase Order means the written or electronic order for the Software submitted by the End User;

I.6 Software means the registered version of the JAWS PDF Editor, together with any changes, modifications, adaptations or
alterations thereto together with any subsequent versions, releases and corrections and any accompanying documentation.
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2 LICENCE

2.1 In consideration of the payment by the End User of the Total Charges, Global Graphics grants to the End User, a non exclu-
sive, non transferable right to install and use the Software on the terms of this Licence

2.2 The End User's rights and obligations in respect to the use of the Software is as follows:
The End User may:

2.3 install and use the number of copies set out in the Purchase Order, provided always that only one copy of the Software on a
single computer subject to both the following conditions being satisfied

24 (a) End User interaction is required to operate the Software;
2.5 (b) there is a one-to-one (I:1) relationship between the End User and the Software.

2.6 Forthe avoidance of doubt the End User is responsible for the installation of the Software and installation must be performed
in accordance with the terms of the documentation accompanying the Software.

2.7 make one copy of the Software for archival purposes, provided the archive copy is not installed or used on any computer;

2.8  use the Software on a network, provided that the End User has a licensed copy of the Software for each computer that can
access the Software over the network. For the avoidance of doubt the End User must not exceed the total numbers of
licensed copies set out in the Purchase Order;

2.9 install an additional copy of the Software on a home or portable computer; provided that the End User is the primary user of
the computer on which the Software was first installed. However, the Software on the secondary computer may not be used
by another person at the same time the Software on the primary computer is being used;

2.10 install additional copies of the Software on the same computer, where the computer is capable of running more than one
operating system (a “multi-boot” system) provided that only one copy of the Software is available for use at any one time;

The End User shall not (and shall procure that any third party shall not):

2.1l copy or make derivative works from the Software, except as set out above. Any copies that you are permitted to make pur-
suant to this Licence must contain the same copyright and other proprietary notices that appear on or in the Software;

2.12 sublicense, assign, rent, lease, lend, export or re-export or otherwise market or distribute the Software, or any portion
thereof

2.13  Modify, change, alter, adapt, translate, reverse engineer, decompile, disassemble or otherwise attempt to discover the source
code of the Software, or create derivative works from the Software, except that in the European Community, you may
reverse engineer only for interoperability purposes and then only if all conditions of Article 6 of Council Directive
91/250/EEC are met.

3 WARRANTY

3.1 Global Graphics warrants to the End User that the Software will perform substantially in accordance with the documentation
supplied with the Software for the ninety (90) day period following receipt by the End User of the Software. To make a war-
ranty claim, the End User must return the Software to the location where obtained it together with a copy of proof of pur-
chase within such ninety (90) day period.

3.2 Ifthe Software does not perform substantially in accordance with the documentation supplied with the Software, the entire
and exclusive liability and remedy shall be limited to either, at Global Graphics option.

3.3 the replacement of the Software; or
34  the refund of the Total Charges

3.5 The warranty set out in this Clause 3.1, and the entire and exclusive liability and remedy set out in Clause 3.2 states the sole
and exclusive obligation of Global Graphics to the End User and sets out the entire remedies which Global Graphics and/or
its licensors have to the End User for breach of this warranty.

4  LIMITATION OF LIABILITY

4.1 Neither party excludes or limits liability to the other party for death or personal injury caused by negligence or for fraud or
fraudulent misrepresentation nor where liability cannot be excluded or limited as a matter of law (e.g. breach of any obliga-
tions implied by Section 12 of the Sale of Goods Act 1979 (as amended) or Section 2 of the Supply of Goods and Services
Act 1982).
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4.2 Subject to the provision of Clause 3.1 and 4.1, all representations, warranties, conditions whether implied by statute or other-
wise are excluded from this Licence. In the case of representations, warranties, conditions implied by statute these are
excluded to the fullest extent permitted by law. [In particular; Global Graphics and its licensors are not aware of the purposes
for which the End User is to use the Software make no warranties, express or implied, as to the Software’s fitness for any par-
ticular purpose.]

4.3 The End Users attention is also drawn to the following and subject always to the provisions of Clauses 3.1 and 4.1, Global
Graphics and its licensors:

4.3.1 do not and cannot warrant that the Software is free from minor errors not materially affecting the performance or
functionality of the Software;

4.32 do not and cannot warrant that the Software is and will be free from viruses (including, but not limited to, hidden rou-
tines, worms, logic or time bombs, disabling or disruptive codes or routines, expiration dates and software switches).
However, whilst Global Graphics has used reasonable endeavours and taken all reasonable steps to check the same, the
End User is solely responsible for performing virus and other checks on the Software.

4.3.3 are not and shall not be liable for any failure or malfunction resulting wholly or to any material extent from the negli-
gence, operator error, any other misuse or abuse of the Software;

4.34 are not and shall not be liable for any failure to comply with the terms of this Licence including but not limited to, the
decompilation, transfer; disassembly, reverse engineering, modification, alteration or adaptation of the Software or its
merger with any other program or any maintenance repair adjustment alteration or enhancement of the Software by
any person other than Global Graphics;

4.3.5 are not and shall not be liable for any failure by the End User to implement recommendations advised by Global
Graphics in respect of, or solutions for faults in, the Software.

44 Subject always to the provisions of Clause 4.1, the aggregate liability of Global Graphics under this Licence (without prejudice
to any non-financial remedies), in contract, tort, misrepresentation or otherwise shall be limited to the Total Charges.

4.5  For the avoidance of doubt, the Supplier shall not have any liability to the Customer for any:
4.5.1 loss of profit, loss of use, loss of savings, goodwill or business interruption; or,
452 indirect, economic, consequential, special or financial loss or damage; or

4.5.3 loss of data.

5 INTELLECTUAL PROPERTY, OWNERSHIP AND RISK

5.1 The Software is and remains the property of Global Graphics and/or its licensors and is protected by amongst other things by
copyright law. All right, title to, ownership of and all Intellectual Property Rights and all other proprietary rights in the Soft-
ware belong to and shall belong to, vest in and shall remain vested in Global Graphics (and its licensors as the case may be).

5.2 In addition, and for the avoidance of doubt, the End User shall have no right to use Global Graphics or its licensor's trade-
marks with its promotion or publication of the Software, without Global Graphics written approval.

5.3 The End User shall not remove any product identification, copyright notices, trade marks or other legends set forth on the
Software and shall reproduce all such notices on any copies.

6  RISK IN THE SOFTWARE PASSES TO THE END USER ON DELIVERY.

7  CONFIDENTIALITY

7.1 The Software is owned by Global Graphics and its licensor(s) and is protected by copyright law, trade secret law, and as oth-
erwise set forth in this Licence.

7.2 The End User agrees not to disclose or make available the Software, or any portion or copy thereof, or the results of any
benchmark tests using the Software, to any third party without Global Graphics prior written consent.

8 TERMINATION

8.1 Global Graphics may terminate this Licence immediately as notice if you fail to comply with any of the terms and conditions
of this Agreement. Upon termination, the End User shall cease using the Software and shall remove the Software from any
personal computer or server and destroy all copies of the Software. Termination of this Agreement shall be without prejudice
to the other rights and remedies of the either party.
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8.2 The provisions of Clauses 4,5 and 6 shall survive the termination of this Agreement as shall any provisions which are
expressed, or by implication are intended, to survive termination of this Agreement.

9  GENERAL
9.1 This Licence shall be governed in all respects by English Law and subject to the non-exclusive jurisdiction of the English
Courts.

9.2 This Licence is personal to the Global Graphics and the End User. Neither party shall assign, novate, sub-contract or other-
wise dispose of all or any part thereof without the previous consent in writing of the other party.

9.3 No variation of this Licence shall be binding upon the parties unless the same shall be in writing duly signed by a director on
its behalf and such variation shall be peculiar to the circumstances mentioned by such writing and shall not be regarded as a
general variation. The failure of either party to insist upon strict performance of any provision of this Licence, or the failure of
either party to exercise any right or remedy to which it is entitled hereunder, shall not constitute a waiver thereof and shall
not cause a diminution of the obligations established by this Licence.

9.4 Except as otherwise expressly provided no Licence communication from one party to the other shall have any validity under
this Licence unless made in writing by or on behalf of either party. Any notice or other communication whatsoever which is
required or authorised by this Licence to give or make to the other, shall be served by e-mail, facsimile or post in a prepaid
first class letter; addressed to Global Graphics at the registered office set out in the pre amble to this Licence. If any notice or
other communication is sent by e-mail, the sender shall confirm the communication by way of a letter sent by first class post.
Any letters sent by first class post which is not returned as being undelivered that notice or communication shall be deemed
for the purposes of this Licence to have been given or made on the second day after posting. Any notice served by facsimile
or telex shall be considered to have been delivered when actually received by the recipient.

9.5  This Licence together with the Schedule to it, represents the entire agreement between the parties and supersedes all prior
agreements, arrangements and understanding between the parties to that subject matter.

9.6 Pursuant to section |(2) of the Contracts (Rights of Third Parties) Act 1999, the parties intend that no term of this Licence
may be enforced by a person who is not a party to this Licence but this does not affect any right or remedy of a third party
which exists or is available apart from under that act.

9.7 If any provision of this Agreement is held invalid, illegal or unenforceable for any reason by any court of competent jurisdic-
tion, such provision shall be severed and the remainder of the provisions hereof shall continue in full force and effect as if this
Licence had been executed with the invalid, illegal or unenforceable provision eliminated.

10 U.S. GOVERNMENT SUPPLY

[0.1 This Software is a commercial computer software program developed at private expense and is subject to the following
Restricted Rights Legend: “Use, duplication, or disclosure by the United States Government is subject to restrictions as set
forth in (i) FAR 52.227-14 Alt Ill, (i) FAR 52.227-19; as applicable. Use by agencies of the Department of Defence (DOD) is
subject to Global Graphics customary commercial license as contained in the accompanying license agreement, in accordance
with DFAR 227.7202-1 (a). For purposes of the FAR, the Software shall be deemed ‘unpublished’ and licensed with disclosure
prohibitions, rights reserved under the copyright laws of the United States.

Il CONTACT INFORMATION

I'1.]" Help and assistance together with detail of support and maintenance are available on the website details of which are set out
in the documentation accompanying the Software. The End User should wherever possible seek help and assistance from and
contact Global Graphics via the website, however any written communications should be sent to the registered office, details
of which are set out in the pre amble to this Licence. If sending mail, or leaving bug reports on the web server, please remem-
ber to include at least your email address so that we can reply to you.

Europe: United States: Web: www.jawspdf.com
Global Graphics Software Limited Global Graphics Software, Inc. E-mail: sales@jawspdf.com
Barrington Hall 5875 Trinity Parkway

Barrington Suite 110

Cambridge, CB2 5RG Centreville, VA 20120

UK USA

telephone +44 1223 873 800 telephone +1 703 266 9588

fax +44 1223 873 873 fax +1 703 266 9582

INDEX | CONTENTS | ¢ 71 »


http://www.jawspdf.com

	Contents
	Introduction
	About this manual
	System Requirements

	Installing and uninstalling PDF Creator
	Installation
	Serial number
	Upgrade from evaluation to a fully working version
	Uninstall PDF Creator

	Getting started with PDF Creator
	Create a PDF file from an application
	Convert a PostScript or Encapsulated PostScript file to PDF
	Create a PDF file containing bookmarks and links
	Create a PDF file using a custom page size
	Change the name or destination folder of the PDF file
	Stop PDF Creator prompting for a file name
	Turn off warning for non-DSC PostScript
	Produce PDF files compatible with PDF viewing applications
	Produce files that can be sent by e-mail
	Produce more compact PDF files
	Launch PDF application to view the file when complete
	Change the author name in the PDF file

	Jaws ToPDF—converting files to PDF
	Using Jaws ToPDF
	Jaws ToPDF configuration

	Configuration Editor reference
	Managing configurations on Mac OS X platforms
	Settings tab (Classic Mac only)
	General tab
	Compression tab
	Font embedding tab
	Security tab
	Advanced tab (Mac OS X only)
	Reporting tab (Classic Mac only)
	About Jaws PDF Creator
	Preferences (Mac OS X only)
	Font management
	Importing configurations
	Exporting configurations

	Support
	Downloading PDF Creator
	Reporting problems
	Registering PDF Creator
	Contact information
	Troubleshooting


	Technical Information
	Index
	COPYRIGHT AND TRADEMARKS
	END USER LICENCE

